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MISS ROWLANDSON'S ALMSHOUSES
England & Wales · Charity number 223522

Details

Other names MISS MARY ROWLANDSON'S ALMSHOUSE CHARITY, GRAYRIGG
ALMSHOUSES

Status Registered

Legal form Trust

Registered 1963-06-26

Register View on the Charity Commission register

Contact

Address 1 Joiners Cottage
Tebay
Penrith
Cumbria
CA10 3XG

Phone 01539624088

Email chaz_robson@hotmail.com

Activities

Objects: A) THE PROVISION OF HOUSING ACCOMMODATION FOR PERSONS OVER THE AGE OF 55
RESIDENT IN THE AREA OF BENEFIT, PREFERENCE BEING GIVEN TO PERSONS LIVING IN THE
CHAPELRY OF GRAYRIGG;B) SUCH CHARITABLE PURPOSES FOR THE BENEFIT OF THE
RESIDENTS AS THE TRUSTEES DECIDE.2) IN EXCEPTIONAL CASES THE TRUSTEES MAY ALLOW
TO OCCUPY AN ALMSHOUSE OF THE CHARITY, SOMEONE ( WHO IS OTHERWISE QUALIFIED) WHO
IS UNDER THE AGE OF 55. 3) THE LAND IDENTIFIED IN PART 1 OF THE SCHEDULE TO THIS
SCHEME MUST BE RETAINED BY THE TRUSTEES FOR USE FOR THE OBJECTS OF THE CHARITY.

Activities: We look after 6 almshouses which are primarily available to people over 55 years of age who live
within the four parishes surrounding Grayrigg or who have a connection with those parishes. In exceptional
circumstances the almshouses are available to people who live outside the area of benefit and who have no
connection with the parishes.

https://opencharities.uk/ew/223522
https://register-of-charities.charitycommission.gov.uk/en/charity-search/?p_p_id=uk_gov_ccew_onereg_charitydetails_web_portlet_CharityDetailsPortlet&p_p_lifecycle=0&p_p_state=maximized&p_p_mode=view&_uk_gov_ccew_onereg_charitydetails_web_portlet_CharityDetailsPortlet_regId=223522
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Classification

• How: Provides Buildings/facilities/open Space

• What: Accommodation/housing

• Who: Elderly/old People

Geography

• Area of benefit: THE CHAPELRY OF GRAYRIGG AND THE CIVIL PARISHES OF OLD HUTTON, NEW
HUTTON, SKELSMERGH, SELSIDE , LONGSLEDDALE, FIRBANK AND HOWGILL.

• Cumbria

Finances

Period end Income Expenditure Assets Employees

2024-12-31 £29,317 £12,810 - -

2023-12-31 £34,216 £5,769 - -

2022-12-31 £27,178 £34,800 - -

2021-12-31 £26,133 £7,436 - -

2020-12-31 £28,994 £7,109 - -

Trustees

Name Role Appointed

SUSANNE BARNES Chair 2009-12-09

CLIFFORD BATEMAN KENDAL 2002-08-05

JEFFREY BURROW 2006-05-04

JOSEPH ROBERT PARKINS 2006-03-09

RICHARD CARL EASTWOOD 2019-11-28

ROGER RICHARD KNOWLES 1998-07-30

Rev Patricia Anne Rogers 2021-03-23

Stephen Andrew Bateman 2016-10-19

https://opencharities.uk/ew/223522


MISS ROWLANDSON'S ALMSHOUSES
England & Wales  -  Charity number 223522

Accounts



 
 Trustees' Annual Report for the period 

 
From 

Period start date 
T
o 

Period end date 
   01   01  2024     31    12           2024 

 
Section A                        Reference and administration details 
 

Charity name  MARY ROWLANDSON'S ALMSHOUSES TRUST 

 

Other names charity is known by  

 
Registered charity number (if any)    223522  

 
Charity's principal address ​

 
1 Joiners Cottage 

Tebay 

Penrith, Cumbria 

Postcode                     CA10 3XG 
 

 Names of the charity trustees who manage the charity 

 Trustee name Office (if any) Dates acted if not for whole 
year 

Name of person (or body) entitled to 
appoint trustee (if any) 

1 Susanne Barnes Chair   
2 Jeffrey Burrow    
3 Roger Knowles    
4 Joseph Parkins    
5 Richard Eastwood    

6 Rev Michelle 
Woodcock 

   

7 Stephen Bateman    
8 Clifford Kendal    
9     

10     
11     
12     
13     
14     
15     
16     
17     
18     
19     
20     

 Names of the trustees for the charity, if any, (for example, any custodian trustees) 

 
Name Dates acted if not for whole year 
  



  
  

 

Names and addresses of advisers (Optional information) 
Type of adviser Name Address 
   

   

   

   

Name of chief executive or names of senior staff members (Optional information) 

 
 
 Section B              Structure, governance and management  

 

Description of the charity’s trusts 

Type of governing document  
(eg. trust deed, constitution)  

  Charity Commissioner's Scheme 26/1/2001 

How the charity is constituted ​
(eg. trust, association, company) 

Trust 

Trustee selection methods ​
(eg. appointed by, elected by) 

Appointed by Trustees 

Additional governance issues (Optional information)  

You may choose to include 
additional information, where 
relevant, about: 

●​ policies and procedures 
adopted for the induction and 
training of trustees;  

●​ the charity’s organisational 
structure and any wider 
network with which the 
charity works; 

●​ relationship with any related 
parties; 

●​ trustees’ consideration of 
major risks and the system 
and procedures to manage 
them.  

 

 

Section C                    Objectives and activities 
 

Summary of the objects of the 
charity set out in its 
governing document 

To provide housing accommodation for persons over the age of 55 
resident in the parish of Grayrigg. 



Summary of the main 
activities undertaken for the 
public benefit in relation to 
these objects (include within 
this section the statutory 
declaration that trustees have 
had regard to the guidance 
issued by the Charity 
Commission on public 
benefit) 

 
Provision of local housing 

Additional details of objectives and activities (Optional information)  
 

You may choose to include 
further statements, where 
relevant, about:  

●​ policy on grantmaking; 

●​ policy programme related 
investment;  

●​ contribution made by  
volunteers.  

 

 
Section D                      Achievements and performance 



 

Summary of the main 
achievements of the charity 
during the year  
 

The properties have been occupied for the year. 
 
Ongoing maintenance was carried out to keep all of the properties in 
good structural condition, regular grass cutting took place to keep the 
outside of the properties neat and tidy. 

 

Section E                    Financial review  
 



Brief statement of the 
charity’s policy on reserves   

The aim of the Trustees is to increase the reserves from accumulated 
income while spending what is necessary on maintaining the properties. 

Details of any funds 
materially in deficit None 

Further financial review details (Optional information) 

You may choose to include 
additional information, where 
relevant about: 
●​ the charity’s principal 

sources of funds (including 
any fundraising);  

●​ how expenditure has 
supported the key objectives 
of the charity;  

●​ investment policy and 
objectives including any 
ethical investment policy 
adopted.  

 

 

Section F                     Other optional information 
 
 

 

Section G                    Declaration 
The trustees declare that they have approved the trustees’ report above.  
 
Signed on behalf of the charity’s trustees 

Signature(s) S.Barnes  

 

Full name(s) Susanne Barnes  

 
Position (eg Secretary, Chair, 

etc) 
Chair  

 
Date  30/10/25  
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Trustees' Annual Report for the period

From

Period start date
T
o

Period end date
01   01  2022   31   12   2022

Section A Reference and administration details

Charity name MARY ROWLANDSON'S ALMSHOUSES TRUST

Other names charity is known by

Registered charity number (if any)   223522

Charity's principal address 1 Joiners Cottage

Tebay

Penrith, Cumbria

Postcode   CA10 3XG

Names of the charity trustees who manage the charity

Trustee name Office (if any) Dates acted if not for whole
year

Name of person (or body) entitled to
appoint trustee (if any)

1 Susanne Barnes Chair
2 Jeffrey Burrow
3 Roger Knowles
4 Joseph Parkins
5 Stephen Bateman
6 Richard Eastwood
7 Clifford Kendal

8 Patricia Anne
Rogers

9
10
11
12
13
14
15
16
17
18
19
20

Names of the trustees for the charity, if any, (for example, any custodian trustees)

Name Dates acted if not for whole year



Names and addresses of advisers (Optional information)
Type of adviser Name Address

Name of chief executive or names of senior staff members (Optional information)

Section B Structure, governance and management

Description of the charity’s trusts

Type of governing document
(eg. trust deed, constitution)

  Charity Commissioner's Scheme 26/1/2001

How the charity is constituted
(eg. trust, association, company)

Trust

Trustee selection methods
(eg. appointed by, elected by)

Appointed by Trustees

Additional governance issues (Optional information)

You may choose to include
additional information, where
relevant, about:

● policies and procedures
adopted for the induction and
training of trustees;

● the charity’s organisational
structure and any wider
network with which the
charity works;

● relationship with any related
parties;

● trustees’ consideration of
major risks and the system
and procedures to manage
them.

Section C Objectives and activities

Summary of the objects of the
charity set out in its
governing document

To provide housing accommodation for persons over the age of 55
resident in the parish of Grayrigg.



Summary of the main
activities undertaken for the
public benefit in relation to
these objects (include within
this section the statutory
declaration that trustees have
had regard to the guidance
issued by the Charity
Commission on public
benefit)

Provision of local housing

Additional details of objectives and activities (Optional information)

You may choose to include
further statements, where
relevant, about:

● policy on grantmaking;

● policy programme related
investment;

● contribution made by
volunteers.

Section D Achievements and performance



Summary of the main
achievements of the charity
during the year

 The properties were occupied for nearly all of the year. One property
was vacant between residents but is now occupied.

Ongoing maintenance was carried out to keep all of the properties in
good structural condition and solar panels have been fitted to all of the
properties.

Section E Financial review



Brief statement of the
charity’s policy on reserves

The aim of the Trustees is to increase the reserves from accumulated
income while spending what is necessary on maintaining the properties.

Details of any funds
materially in deficit None

Further financial review details (Optional information)

You may choose to include
additional information, where
relevant about:
● the charity’s principal

sources of funds (including
any fundraising);

● how expenditure has
supported the key objectives
of the charity;

● investment policy and
objectives including any
ethical investment policy
adopted.

Section F Other optional information

Section G Declaration
The trustees declare that they have approved the trustees’ report above.

Signed on behalf of the charity’s trustees

Signature(s)

Full name(s)

Position (eg Secretary, Chair,
etc)

Date



TO MODIFY FOR THE NEXT YEAR
Make a new copy of the file To modify for the next year: 
In Excel, do this by selecting "File" → "Save as..." and naming it to "#### Accounts", where "####" is the year the account ended
In Google Sheets, select "File → Make a copy" and setting the name to "#### Accounts", where "####" is the year the account ended

HERE'S WHAT YOU CAN AND CANNOT EDIT IN THIS SPREADSHEET

IF A CELL'S CONTENTS ARE IN BLUE, DO NOT EDIT THE CELL. IT CONTAINS A FORMULA THAT WILL BREAK IF IT IS EDITED

The "CCLA Investments", "Accounts Summary 1" and "Accounts Summary 2" sheets require some preparation before you fill in any new values
Select all of column B (click on "B" at the top)
Edit → Copy
Select all of column C
Edit → Paste special → Paste values only
DO NOT DELETE OR MODIFY ANYTHING IN COLUMN B - It will update automatically based on forumlae

"Outgoing" and "Incoming"
Do NOT edit the top three rows. The numbers in these will update automatically
Do NOT type in the "Tag" column. This column features a drop-down list for you to select the appropriate tag from. The tags are used in formulae later on and are important
Delete everything from row 4 and below. The drop-down lists should remain, even if you delete the cell contents

Make sure everything is tagged appropriately in the column with the drop down list - these tags are used to calculate the accounts summary

Fill in the year the sheet is for in the orange cell to the right of this one: 2022



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount
7/1 Rebecca Lewis £600.00 Honorarium

10/1 Almshouse Assoc £187.00 Subscription
12/1 Cumbria Windows £214.25 Deposit Repairs and maintenance
14/1 Rebecca Lewis £28.00 Keys Repairs and maintenance
17/1 Coronation Hall £7.00 Meetings Room hire
26/1 Cumberland £1.50 Cheque Bank charges

Cumberland £9.00 Fees Bank charges
8/2 Rebecca Lewis £336.96 Shed No 1 Repairs and maintenance

3/3/22 United Utilities £151.48 Water
3/3/22 United Utilities £146.18 No. 1 Water
3/3/22 United Utilities £146.18 No. 2 Water
3/3/22 United Utilities £146.18 No. 3 Water
3/3/22 United Utilities £146.18 No.5 Water
9/3/22 United Utilities £146.18 No.6 Water

31/3/22 United Utilities £82.29 No. 1 Water
31/3/22 United Utilities £82.29 No.6 Water
31/3/22 United Utilities £82.29 No. 3 Water
31/3/22 United Utilities £82.29 No.4 Water
31/3/22 United Utilities £82.29 No.5 Water
26/4/22 Cumberland £3.00 Cheques Bank charges
26.4.22 Cumberland £9.00 Fees Bank charges
7.5.22 Cumbria Windows £717.25 Windows Repairs and maintenance
21.5.22 United Utilities £70.44 No.5 Water
21.5.22 United Utilities £70.44 No. 4 Water
21.5.22 United Utilities £70.44 No. 3 Water
21.5.22 Graham Stowe £35.00 No.3 painting Repairs and maintenance
25.5.22 United Utilities £70.44 No. 6 Water



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount
25.5.22 Sue Barnes £65.20 Flowers/ cheese
28.5.22 United Utilities £152.11 No.2 Water
21.6.22 K Aughpin £120.00 Grass cutting Repairs and maintenance
23.7.22 K Aughpin £60.00 Grass cutting Repairs and maintenance
23.7.22 Higos Insurance £1,131.68 Insurance Insurance
26.7.22 Cumberland £9.00 Fees Bank charges
4.8.22 Coronation Hall £14.00 Meetings Room hire
4.8.22 C.Ward £159.00 TV license Repairs and maintenance
4.8.22 United Utlilities £70.44 Water
21.8.22 K Aughpin £60.00 Grass cutting Repairs and maintenance
21.8.22 Peter Tyson £180.00 PAT testing Repairs and maintenance
5.9.22 RJ Solar £7,305.00 Solar panels depositRefurbishment
22.9.22 K Aughpin £60.00 Grass cutting Repairs and maintenance
24.10.22 K Aughpin £63.00 Cleaning Repairs and maintenance
26.10.22 Cumberland £9.00 Fees Bank charges
26.11.22 Clifford Kendal £17.59 Weed killer Repairs and maintenance
26.11.22 C. Ward £600.00 Honorarium Honorarium
30.11.22 RJ Solar £10,000.00Solar panels Refurbishment
01.12.22 RJ Solar £4,915.00 Solar panels Refurbishment
13.12.22 RJ Solar £7,000.00 Solar panels Refurbishment



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



CCLA investments Outgoing total
Total £35,563.09 Total £0.00 £35,563.09

Date of payment Recipient Amount Details Tag Date Amount



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags
4/1 Mark Jones £390.00 10/1 Electricity NW 3.01 Wayleave

K Aughpin £390.00 24/03/22 United Utilities 151.48 Other
Mr & Mrs Austin £390.00 14/4/22 R Lewis 457.53 Other
M Bousie £360.00 28.5.22 R Lewis 305.24 Other

10/1 W Boulton Lear £390.00 08.12.22 CBF Investment 11000 Other
17/1 R Cornthwaite £390.00
31/1 M Bousie £360.00

1/2 M Jones £390.00
K Aughpin £390.00
Mr & Mrs Austin £390.00

10/2 W Boulton Lear £390.00
16/2 R Cornthwaite £390.00

28/02/2022 M Bousie £360.00
01/03/2022 Mr and Mrs Austin £390.00
01/03/2022 K Aughpin £390.00

01/03/22 M Jones £390.00
10/3/22 W Boulton Lear £390.00

16/3/22 R Cornthwaite £390.00
28/3/22 M Bousie £360.00

01/04/2022 M Jones £390.00
01/04/2022 K Aughpin £390.00

1/4/22 Mr and Mrs Austin £390.00
11/4/22 W Boulton Lear £390.00

16/4/22 R Cornthwaite £390.00
25/4/22 M Bousie £360.00
3.5.22 M Jones £390.00
3.5.22 K Aughpin £390.00



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags
3.5.22 Mr and Mrs Austin £390.00
10.5.22 W Boulton Lear £390.00
16.5.22 R Cornthwaite £390.00
23.5.22 M Bousie £360.00
1.6.22 Mr and Mrs Austin £390.00
1.6.22 M Jones £390.00
1.6.22 K Aughpin £390.00
10.6.22 W Boulton Lear £390.00
16.6.22 R Cornthwaite £390.00
20.6.22 M Bousie £360.00
1.7.22 M Jones £390.00
1.7.22 K Aughpin £390.00
1.7.22 Mr and Mrs Austin £390.00
11.7.22 W Boulton Lear £390.00
18.7.22 M Bousie £360.00
1.8.22 M Jones £390.00
1.8.22 K Aughpin £390.00
1.8.22 Mr and Mrs Austin £390.00
10.8.22 W Boulton Lear £390.00
15.8.22 M Bousie £360.00
16.8.22 R Cornthwaite £390.00
1.9.22 M Jones £390.00
1.9.22 K Aughpin £390.00
1.9.22 Mr and Mrs Austin £390.00
12.9.22 M Bousie £360.00
12.9.22 W Boulton Lear £390.00
16.9.22 R Cornthwaite £390.00



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags
3.10.22 M Jones £390.00
3.10.22 K Aughpin £390.00
10.10.22 M Bousie £360.00
10.10.22 W Boulton Lear £390.00
17.10.22 R Cornthwaite £390.00
1.11.22 M Jones £390.00
1.11.22 K Aughpin £390.00
7.11.22 M Bousie £360.00
10.11.22 W Boulton Lear £390.00
22.11.22 T Gow £180.00
29.11.22 R Cornthwaite £780.00
01.12.22 M Jones £390.00
01.12.22 K Aughpin £390.00
05.12.22 M Bousie £360.00
12.12.22 W Boulton Lear £390.00
22.12.22 T Gow £475.00



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



Rent Misc. incoming Incoming total
Total £24,865.00 Total £11,917.26 £36,782.26

Date received Payer Amount Date received Description Amount Tags



2022 2021
Beginning of year £165,918.04 £165,918.04

Net sales/purchases £0.00 £27,000.00

Dividends reinvested £1,192.03 £1,192.03
£1,200.70 £1,200.70
£1,278.58 £1,278.58
£1,388.35 £1,388.35

Dividends reinvested total £5,059.66 £5,059.66

Intermediate total £170,977.70 £197,977.70

Increase/(decrease) in market value (£ 52,281.57)    £25,281.57

Total at year end (£ 223,259.27)  £223,259.27



MARY ROWLANDSON ALMSHOUSES TRUST

RECEIPTS & PAYMENTS FOR YEAR ENDED 31/12/21

2022 2021
£ £

RECEIPTS

Maintenance fees 24,865 26,130
Wayleave 3 3
Interest from The Cumberland 0 0
Other 11,914 0

TOTAL 36,782 26,133

PAYMENTS

Refurbishment 29,220 1,100
Repairs and maintenance 2,051 3,391
Insurance 1,131 1,113
Water 1,646 817
Advertising 0 329
Subscriptions (Almshouse Assoc) 187 0
Honoraria 1,200 619
Room Hire 21 0
Sundry expenses 0 23
Bank charges 40 41
TOTAL 35,563 7,436



MARY ROWLANDSON ALMSHOUSES TRUST

RECEIPTS & PAYMENTS FOR YEAR ENDED 31/12/21

2022 2021
£ £

Net Income from Property 1,219 18,696

Net Sale/(Purchase) of Investments 0 (27,000)

Net receipts/(payments) 1,219 (8,304)

Cash at Bank last year 4,275 12,579

Cash at Bank at year end 5,494 4,275

 



MARY ROWLANDSON ALMSHOUSES TRUST

BALANCE SHEET FOR YEAR ENDED 31/12/21

2022 2021
£ £

ASSETS
Cash at Bank (The Cumberland) 5,494 (4,028)

Investment Assets
Church of England Investment Funds

At beginning of the year 223,259 223,259

Dividends reinvested 5,059 5,059

Net sales/purchases 0 27,000
170,977 197,977

Increase/(reduction) in market value 52,281 25,281

At Year End 223,259 223,259

TOTAL ASSETS 228,754 219,231

ACCUMULATED FUNDS
At beginning of the year 227,534 178,496
Net property income/(expenses) 1,219 (8,304)
Net increase/(reduction) in value of investments 0 57,341



MARY ROWLANDSON ALMSHOUSES TRUST

BALANCE SHEET FOR YEAR ENDED 31/12/21

2022 2021
£ £

At the end of the year 228,753 227,534
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Trustees' Annual Report for the period

From

Period start date

01 01 2021 To

Period end date

31 12 I 2021

a ~ j ~ e ~ r ~ ~ r

Charity name MARY ROWLANDSON'S ALMSHOUSES TRUST

Other names charity is known by

Registered charity number (if any) 223522

Charity's principal address (Ms R Lewis) South View

Grayrigg

Kendal Cumbria

Postcode

Names of the charity trustees who manage the charity

Trustee name Office (if any)
Dates acted if not for whole
year

Name of person (or body) entitled
to appoint trustee (if any)

1 Susanne Barnes Chair

2 Jeffrey Burrow

3 Roger Knowles

4 Joseph Parkins

5 Stephen Bateman

6 Richard Eastwood

7 Clifford Kendal

Patricia Anne
Rogers

9
10
11

12

13
14
15

16

17
18

From 23rd March 2021



19

20

Names of the trustees for the charity, if any, (for example, any custodian trustees)

Name Dates acted if not for whole year

Names and addresses of advisers (Optional information)

Type of adviser Name Address

Name of chief executive or names of senior staff members (Optional information)

~ e ~ ~ ~ a

Description of the charity's trusts

Type of governing document
', 6g trL(St dGB~A CQ(1st!"Ui'Qt'! j

Charity Commissioner's Scheme 26/1/2001

How the charity is constituted
(Bg )~LISt. 85$oc~3iio~. . CGWpBI l&; i

Trustee selection methods
leQ GPPQit i:F 3 o'g' 8!cc', O o'j' j

Trust

Appointed by Trustees

Additional governance issues (Optional information)

You may choose to include
additional information, where
relevant, about:

1. policies and procedures
adopted for the induction and

training of trustees;

2. the charity's organisational
structure and any wider
network with which the
charity works;

3. relationship with any related
parties;

4. trustees' consideration of
major risks and the system



and procedures to manage
them.

A ~ ~ ~ a

Summary of the objects of the
charity set out in its
governing document

To provide housing accommodation for persons over the age of 55
resident in the parish of Grayrigg.

Provision of local housing

Summary of the main
activities undertaken for the
public benefit in relation to
these objects (include within
this section the statutory
declaration that trustees have
had regard to the guidance
issued by the Charity
Commission on public
benefit)



Additional details of objectives and activities (Optional information)

You may choose to include

further statements, where
relevant, about:

1. policy on grantmaking;

2. policy programme related
investment;

3. contribution made by
volunteers.

~ ~ ~ ~ ~



Summary of the main
achievements of the charity
during the year

The properties were occupied for nearly all of the year. One property
was vacant between residents but is now occupied.

Ongoing maintenance was carried out to keep all of the properties in

good structural condition.



Brief statement of the
charity's policy on reserves

The aim of the Trustees is to increase the reserves from accumulated.
income while spending what is necessary on maintaining the properties.

Details of any funds materially
in deficit

None

Further financial review details (Optional information)

You may choose to include
additional information, where
relevant about:

3.

the charity's principal

sources of funds
(including any
fundraising);

how expenditure has
supported the key
objectives of the charity;

investment policy and
objectives including any
ethical investment policy
adopted.

~ ~ ~ ~ ~ e ~

A ~ ~ - . . ~

The trustees declare that they have approved the trustees' report above.

Signed on behalf of the charity's trustees

Signature(s)

Full name(s) T T~-



Position (eg Secretary, Chair,
etc)

Date
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Trustees' annuai report (including Directors' report) for the period

From: 01.01.20 Period start date To: 31.12.20 Period end date

Charity name: Mary Rowlandson Almshouses Charity

Charity registration number: 223522

Company number:

Objectives and activities

Summary of the purposes of
e charity as set out in its

governing document

Summary of the main activities
in relation to those purposes

r the public benefit, in

parbcular, the activities,
projects or services identNed
in the accounts.
Statement confirming whether
he trustees have hsd regard
o the guidance issued by the

Charity Commission on public
benefit

SOAP rafaronaa

Para 1.17

Para 1.1r ariit
1.19

Para 1.18

o provide housing accommodation for
persons over age of 55 In the Parish of
Grayrlgg
Provision of local housing

es

Addltlonai information (optional)
You ma choose to include further statements where relevant about:

Policy on grant making
Para 1.38

Policy on social investment
including program related

investment

Para 1.38

Conbibution made by
volunteers

Para 1.38



Achievements and performance

Summary of the main
achievements of the charity,
identifying the difference the
charity's work has made to the
circumstances of its
beneficiaries and any wider
benefits to society as a whole.

Para 1.20

e properties were occupied for most of
e year, One house was vacant while

being refurbished but is now occupied,

Ongoing maintenance wae carried out to
keep ail of the properties in good structural
condition.

Additional information (optional)
You ma choose to indude further statements where relevant about:

chievements against
objectives set

Para 1.41

Performance of fundraising Para 1.41

acfivities against objecbves set

investment performance
against objectives

Para 1.41

Other



Review of the charity's
nandal position at the end of
e penod

Statement explaining the
policy for holding reserves
stating why they are held

Amount of reserves held

Reasons for holding zero
resolves
Details of fund materially in

de%cit

Para 1.21

Para 1.22

Para 1.22

Para 1.22

Para 1.24

7,100

e aim of the Trustees Is to Increase the
reserves from accumulated income, while
spending what is necessary to maintain

e properties.
142.042

kone

Explanation of any
uncertainties about the charity

ntinuing as a going concern

Addigonal Information (optional)
You ma choose to indude further statements where relevant about'.

he charity's principal sources Para 1.47

f funds (induding any
ndraising)

Investment policy and
Para 1AS

objectives induding any social
investment pohcy adopted

description of the principal
risks facing lhe charity

Other

Structure, governance and management

Description of charity's trusts:

ype of governing document:
r example, trust deed,

memorandum and articles of
association etc
liow is the charity constituted?
or example limited company,

iinini nrpnrntari assni aatinn
CIO

Trustee selection methods

Pare 1.25

Para 1.25

Para 1,25

Charity Commission Scheme dated 26th
anuary 2001.

fust

pointed by Trustees



lection to post or name of any
person or body entitled to

ppoint one or more trustees

Additional information (optional)
You ma choose to indude further statements where relevant about

Policies and procedures
adopted for the induction and
raining of trustees

e charity's organisa5onal
Para 1.51

structure and any wider
network with which the charity
works

Relationship with any related

parties

Para 1.51

Other



Reference and administrative details

Cha name

Other name the charity uses
Ma Rowlandson's Almshouse Charity

Registered charity number 223522
Charity's principal address (ffts R tarwts) South View, Grayrtgg, Kendal, Cumbtta,

Ut(t aeu

Names of the char)ty trustees who manage the charity

Dates anted If not for Name of person (or body) ennead to appoint trnetee (If

any)
ole year any)

Chair Mrs Suzanne Bames

Mr Clifford Kendal

Mr Roger Know)es

Mr Joseph Parkins

Mr Jeffrey Burrow

Mr Stephen Batsman

Mr Richard Eastman

From 23.3.21 Rev Patricia Rogers

10

11

12

13

14

15

16

17

18

19

20

rate trustees —names of the directors at the date the rt was a roved
Director name
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Corporate trustees —names of the directors at the date the report was approved

Director name

Name of trustees holding title to property belonging to the charity

Trustee name Dates acted if not for whole
year
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Description of the assets held in this

capacity

Name and objects of the charily

nn whnse hehalf the assets are

held and how this falls within the

custodian charity's objects

Details ol arrangements for safe

custody and segregation of such

assets from the charity's own assets

Additional information (optional)

Names and addresses of advisers (Optional information)

Type of adviser Name Address

Name of chief executive or names of senior staff members (Optional information)

Exemptions from disdosure

Reason for non-disdosure of key pe~sonnet details

Other optional information
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The trustees declare that they have approved the trustees' report abave.

Signed on behalf of the charity's trustees

gggatgre(gf

%u'S+e gr" 6 ~PF ft,'Sg scen Jar Z
Full nafne(s)

fsaCLw ~cu !5

Position (eg Secretary,

Chair, etc)
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MARY ROWLANDSON ALMSHOUSES TRUST
Charity number: 223622

INDEPENDENT EXAMINER'S REPORT TO THE TRUSTEES ON THE TRUST'8
ACCOUNTS FOR THE YEAR ENDED 31 DECEMBER 2020
set out on pages 2 and 3

Respective responsibilities of trustees and examiner
The charity's tfustees are responsible for the preparation of the accounts. The
charity's trustees consider that an audit is not required for this year under section
144 of the Charities Act 2011 (the Charities Act) and that an independent
examination is needed. It is my responsibility to:
— examine the accounts under section 145 of the Charities Act,
- follow the procedures laid down in the general Directions given by the Charity

Commission (under section 145(5) of the Charities Act), and
- state whether particular matters have come to my attention.

Basis of independent examiner's statement
My examination was carried out in accordance with general Directions given by the
Charity Commission. An examination includes a review of the accounting records
kept by the charity and a comparison of the accounts presented with those records.
It also includes consideration of any unusual items or disclosures in the accounts,
and seeking exp'lanations from the trustees concerning any such matters. The
procedures undertaken do not provide all the evidence that would be required in an
audit, and consequently no opinion is given as to whether the accounts present a
"true and fair" view and the reoort is limited to those matters set out in the
statement below.

Independent examiner's statement
In connection with my examination, no matter has come to my attention
1 which gives me reasonable cause to believe that, in any material respect, the
requirements to keep accounting records in accordance with section 130 of the
Charities Act and to prepare accounts which accord with the accounting records
and comply with the accounting requirements of the Charities Act have not been
met; or
2 to which, in my opinion, attention should be drawn to enable a proper
understanding of the accounts to be reached.

Signed

24 February 2021

David John Ellis
Fellow of the institute of Chartered Accountants in England and Wales
Oldfield Barn, Docker, Kendal, Cumbria

Page 1



MARY ROWLANDSON ALMSHOUSES TRUST

RECEIPTS AND PAYMENTS IN THE YEAR ENDED 31 DECEMBER 2020

2020 2019
E E

RECEIPTS

Maintenance fees
Bank interest
Wayleave

28,980
11

28 994

26,610
3

26 616

PAYMENTS

Refurbishment of No. 3 (2019 - No. 2)
Repairs and maintenance
Insurance
Water
Advertising
Subscriptions
Honoraria
Room hire
Bank charges

1,975
2, 195
1,085

860
117
361
500

16
7 109

3,012
1,498
1,049

899
40

170
530

7

7 205

NET PROPERTY RECEIPTS

NET PURCHASE
OF INVESTMENTS

NET RECEIPTS

CASH AT BANK LAST YEAR

CASH AT BANK AT YEAR END

21,885

20 000

1,885

106 3

't2, 578

19,411

17 000

2,411

8 282

10,693



AARY ROWLANDSON ALMSHOUSES TRUST

BALANCE SHEET AT 31 DECEMBER 2020

31.12.20
f

31.12.19

ASSETS

CASH AT BANK
The Cumberland account

INVESTMENT
The CBF Church of England Investment Fund
At the beginning of the year
Dividends reinvested
Purchases

Increase in market value
At the end of the year

TOTAL ASSETS

~1578

131,349
4,205

20 000
155,554
~1364

166 916

178,496

10 693

92,524
3,407

17 000
112,931
18 418

131 349

142,042

ACCUMULATED FUNDS

At the beginning of the year
Net receipts
Net increase in value of investments,

At the end of the year

142,042
1,885

178,496

100,806
2,411

ZL825

142,042
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MARY ROWLANDSON ALMSHOUSES TRUST
Charity number: 223622
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It also includes consideration of any unusual items or disclosures in the accounts,
and seeking exp'lanations from the trustees concerning any such matters. The
procedures undertaken do not provide all the evidence that would be required in an
audit, and consequently no opinion is given as to whether the accounts present a
"true and fair" view and the reoort is limited to those matters set out in the
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Signed
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David John Ellis
Fellow of the institute of Chartered Accountants in England and Wales
Oldfield Barn, Docker, Kendal, Cumbria

Page 1



MARY ROWLANDSON ALMSHOUSES TRUST

RECEIPTS AND PAYMENTS IN THE YEAR ENDED 31 DECEMBER 2020

2020 2019
E E

RECEIPTS

Maintenance fees
Bank interest
Wayleave

28,980
11

28 994

26,610
3

26 616

PAYMENTS

Refurbishment of No. 3 (2019 - No. 2)
Repairs and maintenance
Insurance
Water
Advertising
Subscriptions
Honoraria
Room hire
Bank charges

1,975
2, 195
1,085

860
117
361
500

16
7 109

3,012
1,498
1,049

899
40

170
530

7

7 205

NET PROPERTY RECEIPTS

NET PURCHASE
OF INVESTMENTS

NET RECEIPTS

CASH AT BANK LAST YEAR

CASH AT BANK AT YEAR END

21,885

20 000

1,885

106 3

't2, 578

19,411

17 000

2,411

8 282

10,693



AARY ROWLANDSON ALMSHOUSES TRUST

BALANCE SHEET AT 31 DECEMBER 2020

31.12.20
f

31.12.19

ASSETS

CASH AT BANK
The Cumberland account

INVESTMENT
The CBF Church of England Investment Fund
At the beginning of the year
Dividends reinvested
Purchases

Increase in market value
At the end of the year

TOTAL ASSETS

~1578

131,349
4,205

20 000
155,554
~1364

166 916

178,496

10 693

92,524
3,407

17 000
112,931
18 418

131 349

142,042

ACCUMULATED FUNDS

At the beginning of the year
Net receipts
Net increase in value of investments,

At the end of the year

142,042
1,885

178,496

100,806
2,411

ZL825

142,042

Page 3


	Summary
	Accounts - 2024-12-31
	Accounts - 2023-12-31
	Accounts - 2022-12-31
	Accounts - 2021-12-31
	Accounts - 2020-12-31

